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Informazioni su...
In breve

Scopo del documento

La guida rapida descrive, mediante un esempio di applicazione, le varie fasi necessarie ad installare, 
configurare e controllare velocemente le partenze motore  TeSys U . La guida rapida consente a chi 
abbia un'esperienza di base in materia di PLC e software applicativi (Unity Pro, Sycon e così via) di 
configurare senza difficoltà una rete di comunicazione Profibus DP. A questo scopo non occorre 
consultare ulteriore documentazione. 

Per ulteriori dettagli sulle altre funzioni delle partenze motore TeSys U consultare la documentazione 
elencata di seguito.

Documenti correlati

E' possibile scaricare queste pubblicazioni e tutte le altre informazioni tecniche dal sito www.schneider-
electric.com.

Commenti utente

Inviare eventuali commenti all'indirzzo e-mail techcomm@schneider-electric.com.

Titolo della documentazione Reference Number

TeSys U LULC07 Modulo di comunicazione Profibus DP - Manuale d'uso 1672610

Variabili di comunicazione TeSys U – Manuale d'uso 1744082

Partenze TeSys U LUB/LUS – Scheda di istruzioni 1629984

Unità di controllo TeSys U LUCA/LUCB/LUCC/LUCD – Scheda di istruzioni AAV40503

DFB TeSys - Manuale d'uso 1672600

TeSys U LULC07 Modulo di comunicazione Profibus DP - Guida introduttiva 1672611

TeSys U LULC07 Modulo di comunicazione Profibus DP - Nota applicativa 1672612
1672606 06/2009



1672606 06/2009
1

Introduzione
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Introduzione 
Contenuto di questo capitolo

Questo capitolo contiene le seguenti sottosezioni:

Presentazione dell'applicazione

Introduzione

Questo esempio applicativo illustra le fasi che consentono di definire partenze motore ad azionamento 
diretto (DOL) allo scopo di: 
 garantire protezione magnetotermica
 comandare il motore e
 ottenere il segnale di feedback dal contattore e dall'intervento dell'interruttore automatico

Descrizione dell'applicazione

 Motore 1 (M1):
Motore trifase, classe 10, 5,5 kW (7.5 hp) a 440 V, 50 Hz, corrente nominale In = 10,5 A DOL 

 Motore 2 (M2):
Motore trifase, classe 20, 7,5 kW (10 hp) a 440 V, 50 Hz, corrente nominale In = 14,7 A DOL con 
controllo a distanza del carico motore

Soluzione tradizionale

Lo schema seguente mostra il cablaggio di una soluzione tradizionale: tutti i comandi e le informazioni di 
feedback sono cablati attraverso il PLC.
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Introduzione
La soluzione Schneider Electric con le partenze motore Tesys U

Schemi di alimentazione e comando della soluzione Schneider Electric

Unità di controllo per la soluzione Schneider Electric

La soluzione Schneider Electric presentata in questa guida rapida risponde a diverse esigenze 
applicative utilizzando i moduli TeSys U.

 LUCA12BL è un'unità di controllo standard utilizzata con il motore 1 per svolgere funzioni di base:
 controllo remoto di un motore (start/stop)
 informazioni di stato (pronto, in marcia, errore)

 LUCD18BL è un'unità di controllo avanzato utilizzata con il motore 2, con funzionalità più avanzate 
che si aggiungono a quelle standard:
 allarme
 ripristino automatico e a distanza tramite il bus
 indicazione del carico del motore
 differenziazione degli errori

Schema di alimentazione Schema di comando

1. TSX PBY 100 Accoppiatore master Profibus DP con 
scheda PCMCIA, cavo e presa
2. Scatola di distribuzione LU9GC7 con 2 connettori 
D-sub 9 pin (connessione bus al modulo LULC07) e 
morsetti a vite (24 V)
3. Collegamento bobina precablata LU9BN11L
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LUCAppBL
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TeSys U TeSys U
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24 Vdc
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7.5 kW

Q2
KM2

M2

24 Vdc 24 Vdc

LU9GC7

IN OUT

24V DC

Modicon TSX

Interface 1
PROFIBUS
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Interface 2
host

490 NAE 911 00
PROFIBUS-TAP

2

3 3

LUCDppLUCApp
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TeSys UTeSys U
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Introduzione
Architettura del sistema TeSys U

L'immagine seguente descrive i componenti principali di un sistema TeSys U montato su pannello:

Legenda Nome commerciale Descrizione

1+2+3+4 Controller logico programmabile (PLC) Premium comprensivo di tre moduli: 
alimentatore (1), processore (2) e PCMCIA (3) su rack (4)

1 TSX PSY 5500M Modulo di alimentazione Premium

2 TSX P57 354M Processore Premium

3 TSX PBY 100 Modulo PCMCIA Premium comprensivo di:
 modulo per la scheda PCMCIA
 scheda PCMCIA Profibus DP con cavo di connessione integrato, lungo 

0,6 m (2 ft)
 presa 490 NAE 911 00 Profibus con 1 connettore femmina D-sub 9 pin 

(sx) e un connettore maschio D-sub 15 pin (dx)

4 TSX RKY 6 Rack singolo Premium (6 posizioni) per l'installazione meccanica ed elettrica 
di tutti i moduli Premium

5 490 NAD 911 03 (or 04) Connettore

6 TSX PBSCA100 Cavo da 100 m (328 ft), da tagliare in base alle dimensioni della rete

7 LU9GC7 Scatola di distribuzione con 2 connettori D-sub 9 pin (connessione bus) e 
morsetti a vite (24 V)

8 LUB12 Base di potenza TeSys U

9 LUCA12BL Unità di controllo standard

10, 13, 17 LULC07 Modulo di comunicazione Profibus DP con morsettiera plug-in per il 
comando diretto dei morsetti A1/A2

11 LUB32 Base di potenza TeSys U

12 LUCD18BL Unità di controllo avanzato

14 LU9AD7 Connettore per connessione a margherita
 Fine linea connettore slave 1 = OFF
 Fine linea connettore slave 2 = ON

15 TSX PBS 100 Cavo da 100 m (328 ft), da tagliare in base alle dimensioni della rete

16 LU9BN11L Collegamento bobina precablata (opzionale)

1 2 3 54 6 7 8 119 10

14

15

12

13

17 16
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Introduzione
Strumenti software

Per configurare l'applicazione occorrono i seguenti strumenti software. Il loro uso richiede un minimo di 
esperienza in materia.

Condizioni della rete

Protocollo: Profibus DP

Velocità di trasmissione: 1.500 kbps

Indirizzi:
 1 per TeSys U motore 1
 2 per TeSys U motore 2

Strategia di fallback:

Se la comunicazione con il PLC si interrompe, la strategia di fallback permette di azionare il motore in 
modi diversi. Impostare il parametro 682 su uno dei valori seguenti:

La strategia di fallback adatta all'applicazione in oggetto è:
 Valore 1 = congelamento per il motore 1
 Valore 2 = arresto forzato per il motore 2

Nome commerciale Freeware Descrizione

UNY SPU EFP CD40 – Software di programmazione Unity Pro Extra Large V 4.0 per 
PLC Premium

SYCSPULFUCD29M – Software per la configurazione di rete Sycon V 2.9 per PLC 
Premium (licenza monoutente) 

– Libreria DFB, compreso 
Ctrl_pfb_u_ms

Controllo/comando ciclico TeSys U per MS Profibus DP. 
Scaricare la libreria DFB TeSys U dal sito www.schneider-
electric.com

Valore parametro 682 Modalità di fallback Descrizione

0 Disabilitata Nessuna strategia. Scelta non consigliata.

1 Congelamento Quando viene individuata un'interruzione della comunicazione il 
motore mantiene il proprio stato:
 Se in marcia, continua a funzionare.
 Se fermo, rimane fermo.

Le modifiche dello stato di controllo non sono autorizzate. Un nuovo 
comando viene preso in considerazione solo dopo aver ripristinato 
l'interruzione di comunicazione (703.3).

2 Arresto forzato 
(impostazione 
predefinita)

Il motore viene forzato all'arresto.
Uscita OA1 = 0
Uscita OA3 = 0

3 Nessuna variazione Le modifiche dello stato di controllo sono autorizzate. Un nuovo 
comando viene preso in considerazione anche prima di ripristinare 
l'interruzione di comunicazione (703.3).

4 Marcia avanti forzata Uscita OA1 = 1 (avanti) 
Uscita OA3 = 0

5 Marcia indietro 
forzata

Uscita OA1 = 0
Uscita OA3 = 1 (indietro)
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Configurazione del TeSys U
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Configurazione del TeSys U
Contenuto di questo capitolo

Questo capitolo contiene le seguenti sottosezioni:

Impostazioni di LUCA12BL e LUCD18BL

Regolazione della corrente sulle unità di controllo

La figura seguente spiega come regolare la corrente sull'unità di controllo (in questo caso LUCA12BL) 
per mezzo di un cacciavite:

Valori di regolazione della corrente

La tabella seguente illustra le regolazioni per i moduli LUCA12BL (unità di controllo standard) e 
LUCD18BL (unità di controllo avanzato):

Argomento Pagina

Impostazioni di LUCA12BL e LUCD18BL 9

Connettori LULC07 e impostazioni dell'indirizzo 10

4.00A

LUCA / LUCD

LULC07

5.00A

7.00A

9.00A

12.0A

3.00A

TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Unità di controllo Motore Range di regolazione 
della corrente

Potenza nominale 
del motore

Valore di regolazione della corrente = 
corrente nominale del motore

LUCA12BL M1 3..12 A 5,5 kW (7.5 hp) 10,5 A

LUCD18BL M2 4.4..18 A 7,5 kW (10 hp) 14,7 A
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Configurazione del TeSys U
Connettori LULC07 e impostazioni dell'indirizzo

Presentazione

Per impostare l'indirizzo Profibus DP utilizzare i DIP switch sotto il modulo di comunicazione LULC07.

1 Connettore D-sub 9 pin Profibus DP
2 Morsettiera di ingresso/uscita e 24 Vdc
3 Indirizzo

Indirizzo

Assegnare un indirizzo da 1 a 127 con i 7 selettori all'estrema destra (da SW1 a SW7). L'indirizzo 0 (zero) 
non è consentito e si considera una configurazione non valida.

Nell'applicazione di esempio gli indirizzi sono 1 e 2:

321

LO1LI1LI2
24V c

VP
P24

RxD/TxD-N

M24
RxD/TxD-P CNTR-P

DGND

SW7 SW6 SW5 SW4 SW3 SW2 SW1 Indirizzo

0 0 0 0 0 0 1 1 (valore predefinito)

0 0 0 0 0 1 0 2

Indirizzo 1 per TeSys U motore 1 Indirizzo 2 per TeSys U motore 2

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off
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Configurazione di una rete di comunicazione con un PLC
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Configurazione di una rete di comunicazione 
con un PLC
Introduzione

Questo capitolo illustra le fasi che consentono di configurare la comunicazione con un PLC Premium 
utilizzando:
 Unity Pro e
 Sycon.

Contenuto di questo capitolo

Questo capitolo contiene le seguenti sottosezioni:

Argomento Pagina

3.1 Configurazione di TeSys U sulla rete Profibus DP con Unity Pro e Sycon 12

3.2. Configurazione dei DFB con l'applicazione 19
11



Configurazione di una rete di comunicazione con un PLC
3.1 Configurazione di TeSys U sulla rete Profibus DP con Unity Pro e Sycon

Procedura di configurazione per un PLC Premium

1) Download dei file GSD

La tabella seguente descrive la procedura per scaricare dal sito www.schneider-electric.com i file GSD e 
di icona associati a Tesys U:

Passo Azione

1 Collegarsi al sito Schneider Electric: www.schneider-electric.com.

2 Fare clic su Products and Services (prodotti e servizi), quindi su Automation and Control (controllo 
e automazione).

3 Nella sezione Downloads (download) sulla barra dei menu di sinistra, fare clic su Current offers 
(offerte correnti).

4  Selezionare Motor Control (controllo motore) nell'elenco a discesa Choose a function (scegliere 
una funzione).

 Selezionare TeSys U nell'elenco a discesa Choose a range (scegliere una gamma).
 Selezionare Software/Firmware (software/firmware) nell'elenco a discesa Choose a type of 

document (scegliere un tipo di documento).

Fare clic su >Find (trova).

5 Selezionare Communication Module Tesys U PROFIBUS LULC07 (modulo di comunicazione Tesys 
U PROFIBUS LULC07) e scaricare il file LULC07_GSD_DIB_files_V100.exe.

6 Fare doppio clic su LULC07_GSD_DIB_files_V100.exe nel disco rigido. Fare clic su Accept (accetto) 
nella finestra "Licence for software downloaded from Schneider-Electric web sites", (licenza per 
software scaricato dal sito Schneider Electric), quindi scegliere la cartella di destinazione e fare clic su 
Install (installa).

7 Selezionare il file GSD: TELE094C.GSD
12 1672606 06/2009



Configurazione di una rete di comunicazione con un PLC
2) Configurare la rete per l'applicazione

Di seguito si descrivono le prime fasi della configurazione con il software Unity Pro XL:

 

Passo Azione

1 Lanciare il software Unity Pro XL V4.0.

2 Configurare il PLC Premium e gli accessori di comunicazione (scheda PCMCIA e così via):

3 Salvare l'applicazione in un file .STU.

4 Fare doppio clic sull'accoppiatore TSX PBY 100 . Si apre la finestra di configurazione del modulo 
PROFIBUS-DP: 

Probabilmente non occorre modificarla. 
Per continuare la procedura di configurazione fare clic sul pulsante Sycon (hilscher). Se il pulsante non 
è visualizzato, ripetere l'installazione del software Sycon.
1672606 06/2009 13



Configurazione di una rete di comunicazione con un PLC
Continuare la procedura di configurazione con il software Sycon come descritto di seguito:

Passo Azione

1 Nel software Sycon V2.9, selezionare File → New.

2 Nella finestra di dialogo Select fieldbus selezionare Profibus DP e confermare.

3 Importare il file GSD selezionando File → Copy GSD.

4 Sfogliare fino al file TELE094C.GSD .

5 Inserire un master: 
 fare clic su Insert → Master... oppure

 selezionare 

6 Fare doppio clic sul menu Setting (impostazione) e selezionare Master Configuration (configurazione 
master): la casella Auto addressing (impostazione automatica indirizzo) è selezionata di default. 
Questo significa che non è necessario modificare gli indirizzi di ingresso e uscita per i nodi 1 e 2. Se si 
deseleziona la casella, sarà necessario modificarli.
 
Nella finestra Insert Master selezionare TSX PBY 100 dall'elenco Available masters. Fare clic sul 
pulsante Add>>. Inserire un indirizzo in Station address, ad es. 10. 

Confermare facendo clic su OK.

7 Inserire un nodo: 
 fare clic su Insert → Slave... oppure

 selezionare 

8 Nella finestra Insert Slave selezionare LULC07 - TeSys U Profibus dall'elenco Available slaves: 

Lo slave 1 è all'indirizzo 1. Lo slave 2 è all'indirizzo 2. 
14 1672606 06/2009



Configurazione di una rete di comunicazione con un PLC
9 Per impostare il parametro del bus, selezionare il master sullo schermo, quindi fare clic su Settings → 
Bus Parameter:

Impostare Baudrate su 1500 kBits/s e confermare con OK.

10 Fare doppio clic su un nodo per aprire la finestra Slave Configuration:

Dall'elenco Module (modulo) selezionare:
 Sc_St_R_MS per lo Slave1
 Sc_Ad_R_MS per lo Slave2

Abbreviazioni: 
 Sc: Starter-controller, (controller avviatore) 
 St: unità di controllo standard; Ad: unità di controllo avanzata
 R: controllo remoto
 MS: partenza motore

NOTA: per passare da slave 1 a slave 2 è possibile intervenire su questa finestra, cambiando slave 
nella casella Actual slave (slave corrente), oppure fare doppio clic su Slave 2 nella struttura ad albero. 

Passo Azione
1672606 06/2009 15



Configurazione di una rete di comunicazione con un PLC
11 Per definire una strategia di fallback per perdita di comunicazione, fare clic sul pulsante Parameter Data 
(dati dei parametri). Nella finestra Parameter Data, fare clic sul pulsante Module.
Selezionare la prima voce dell'elenco e impostare la strategia di fallback per perdita di comunicazione 
dall'elenco a discesa: 

 Freeze outputs (congela uscite) per lo slave 1
 Force stop (forza arresto) per lo slave 2

Confermare facendo clic su OK.

12 Salvare la configurazione selezionando File → Save as. Il file di configurazione ha estensione .PB. 
Trasformare il file in formato ASCII facendo clic su File → Export → ASCII, per utilizzarlo in Unity Pro.
Uscire da Sycon.

Passo Azione
16 1672606 06/2009



Configurazione di una rete di comunicazione con un PLC
Completare la procedura di configurazione con il software Unity Pro XL nella finestra PROFIBUS-DP 
MODULE : 

Passo Azione

1 NOTA: nella finestra di configurazione, (1), (2) e (3) corrispondono ai passi 1, 2 e 3.

Selezionare il pulsante Load CNF e aprire il file .CNF.

2 Modificare il valore predefinito Diagnostic Length e le informazioni del telegramma di diagnostica per 
Profibus DP contenute nel manuale d'uso di TeSys U LULC07 Profibus DP:
 Valore predefinito (in byte) = 32
 Valore nuovo = 36

3 Per ottimizzare lo spazio in memoria, impostare No. of IW/QW  (numero di IW/QW) dall'elenco a 
discesa:
 Valore predefinito = 128
 Valore nuovo = 32

4
Per convalidare la configurazione selezionare Edit → Validate (modifica, conferma) o fare clic su . 

5 Selezionare Build → Rebuild all project (genera, rigenera tutto il progetto).
1672606 06/2009 17



Configurazione di una rete di comunicazione con un PLC
3) Eseguire il test funzionale della rete di comunicazione, compresi il PLC e i prodotti Premium 

Passo Azione

1 Collegare il cavo di programmazione idoneo tra PC e PLC Premium.

2 Accendere il PLC Premium.

3 Selezionare Connect.

4 Trasferire il progetto dal menu PLC.

5 Accendere i 2 sistemi TeSys U, quindi fare clic su Run (esegui). 
A questo punto, la comunicazione è correttamente stabilita: il LED rosso di stato di comunicazione BF è 
spento, e il LED verde 24V è acceso. Se invece il LED rosso di guasto ERR lampeggia, la comunicazione 
si è interrotta.

6 La finestra PROFIBUS-DP MODULE ha una scheda Debug da cui sono state estratte le tabelle 
seguenti, con gli indirizzi che contengono gli scambi ciclici per ogni apparecchiatura. Denominare le 
variabili evitando nomi che non forniscano indicazioni sul contenuto della posizione di memoria (ad 
esempio usare Ready_M1 invece di %IW0.3.0).

In caso di errore di comunicazione a livello di uno slave, nell'elenco PROFIBUS-DP slave configuration 
(configurazione slave PROFIBUS DP) la voce corrispondente appare rossa e nella casella di diagnostica 
viene visualizzato un messaggio esplicativo.
I dati scambiati ciclicamente appaiono nella colonna Value (valore).
18 1672606 06/2009



Configurazione di una rete di comunicazione con un PLC
3.2. Configurazione dei DFB con l'applicazione

Presentazione

I DFB (Derived Function Blocks, blocchi funzione derivati) TeSys sono stati sviluppati per semplificare e 
ottimizzare l'integrazione dei controller avviatori TeSys U nelle applicazioni PLC.

Il DFB Ctrl_pfb_u_ms è dedicato al controllo e comando di un controller avviatore TeSys U singolo (fino 
a 32 A/15 kW) tramite la rete Profibus DP MS (partenza motore).

1. Scaricare i file DFB
2. Installare i DFB in Unity Pro
3. Cercare il progetto e l'applicazione DFB in Unity Pro

Per ulteriori informazioni vedere il manuale d'uso TeSys DFB.

1) Scaricare i file DFB

La tabella seguente spiega come scaricare i file TeSys DFB dal sito www.schneider-electric.com:

2) Installare i DFB in Unity Pro

Passo Azione

1 Collegarsi al sito Schneider Electric: www.schneider-electric.com

2 Fare clic su Products and Services (prodotti e servizi), quindi su Automation and Control (controllo 
e automazione).

3 Nella sezione Downloads (download) sulla barra dei menu di sinistra, selezionare Current offers 
(offerte correnti).

4  Selezionare Motor Control (controllo motore) nell'elenco a discesa Choose a function (scegliere 
una funzione).

 Selezionare TeSys U nell'elenco a discesa Choose a range (scegliere una gamma).
 Selezionare Software/Firmware (software/firmware) nell'elenco a discesa Choose a type of 

document (scegliere un tipo di documento).

Fare clic su >Find (trova).

5 Selezionare TeSys DFB offer package (pacchetto TeSys DFB) e scaricare il file compresso sul disco 
rigido.

6 Estrarre il contenuto del file TeSys DFB offer package.zip in una sola cartella sul disco rigido. Verranno 
create due cartelle, PL7 Pro e Unity Pro, ciascuna contenente le seguenti sottocartelle:

Passo Azione

1
Selezionare  Start, Tutti i programmi, quindi andare a  Schneider Electric → Unity Pro → Types 
Library Update (aggiornamento libreria tipi).

2 Nella finestra Types Library Update, andare a 04 Cyclic control command (04 Comando controllo 
ciclico)  → FAMILY.DSC e aprire il file. 
NOTA: La versione dell'applicazione selezionata deve essere compatibile con Unity Pro.

3 Fare clic sul pulsante Install family. Viene visualizzata una finestra a comparsa con il messaggio: “The 
installation has succeeded” (l'installazione è avvenuta correttamente). A questo punto uscire.
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Configurazione di una rete di comunicazione con un PLC
3) Cercare il progetto e l'applicazione DFB in Unity Pro

Passo Azione

1 Avviare il software Unity Pro.

2 Aprire la sezione FDB di un programma. Dal menu Edit accedere al sottomenu Data Selection.... 
Si apre la finestra Function Input Assistant (assistente ingresso funzione) vuota. La prima voce è 
FFB type. Sfogliare fino a trovare il DFB Profibus Ctrl_pfb_u_ms. Si apre la finestra seguente:

Confermare facendo clic su OK.

3 Ora la finestra Function Input Assistant visualizza la voce selezionata:

Confermare facendo clic su OK.

4 Viene visualizzata la rappresentazione grafica del DFB:
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Configurazione di una rete di comunicazione con un PLC
Caratteristiche degli ingressi

La tabella seguente descrive gli ingressi del DFB e la loro disponibilità in base all'unità di controllo:

Caratteristiche delle uscite

La tabella seguente descrive le uscite del DFB e la loro disponibilità in base all'unità di controllo:

Ingresso Tipo Range Valore 
predefinito

Descrizione LUCA LUCD

Ms_in1 INT _ 0 Per il collegamento alla prima parola dei dati 
ciclici di ingresso dello slave Profibus MS

√ √

Run_fwd EBOOL 0...1 0 Comando motore marcia avanti √ √

Run_rev EBOOL 0...1 0 Comando motore marcia indietro √ √

Rst_flt EBOOL 0...1 0 Ripristino dopo guasto (in caso di guasto del 
modulo di comunicazione, riporta il modulo alle 
impostazioni di fabbrica)

√ √

Rst_warn EBOOL 0...1 0 Ripristino allarme (ad esempio interruzione della 
comunicazione)

√ √

Em_strt EBOOL 0...1 0 Avvio di emergenza (ripristina la memoria 
termica)

  

Trip_tst EBOOL 0...1 0 Test di disinnesto per sovracorrente tramite bus 
di comunicazione

  

Uscita Tipo Range Valore 
predefinito

Descrizione LUCA LUCD

Ms_out1 INT _ 0 Per il collegamento alla prima parola dei dati ciclici 
di uscita dello slave Profibus MS

√ √

Ready EBOOL 0...1 0 Sistema pronto: la manopola è in posizione On e 
non vi sono guasti

√ √

Closed EBOOL 0...1 0 Stato del polo: chiuso √ √

Tripped EBOOL 0...1 0 Sistema intervenuto: la manopola è in posizione 
Trip

√ √

Fault EBOOL 0...1 0 Tutti i guasti √ √

Alarm EBOOL 0...1 0 Tutti gli allarmi √ √

Rst_auth EBOOL 0...1 0 Ripristino errore autorizzato  √

Starting EBOOL 0...1 0 Avviamento in corso:
1 = corrente in salita superiore al 10 % FLA
0 = corrente in discesa inferiore al 150 % FLA

 √

Running EBOOL 0...1 0 Motore in marcia con rilevamento di corrente, se 
superiore al 10 % FLA

 √

Avg_curr INT 0...200 0 Corrente media motore (% FLA)  √
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Configurazione di una rete di comunicazione con un PLC
Programmazione DFB (=M1) per il motore 1

Programmazione DFB (=M2) per il motore 2

Passo Azione

1 Collegare l'ingresso Run_fw alla condizione di avviamento del motore 1.

2 Collegare le uscite M1 alle variabili PLC da usare nel programma:
 Uscita M1 chiusa = posizione del contattore KM1
 Uscita M1 intervenuta = posizione intervenuta di Q1 TeSys U

3 Controllare che M1 del motore 1 venga visualizzato come segue:

1 Non applicabile
2 Applicabile, ma non usato; può essere gestito dall'applicazione PLC

Passo Azione

1 Collegare l'ingresso Run_fw M2 alla condizione di avviamento del motore 2.

2 Collegare le uscite M2 alle variabili PLC da usare nel programma:
 Uscita M2 chiusa = posizione del contattore KM2
 Uscita M2 intervenuta = posizione intervenuta di Q2 TeSys U

3 Collegare l'uscita Avg_curr M2 a un registro PLC per usare la corrente media del motore 2 nel 
programma.

4 Controllare che M2 del motore 2 venga visualizzato come segue:

1 Non applicabile
2 Applicabile, ma non usato; può essere gestito dall'applicazione PLC
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